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HOW TO USE THIS MANUAL  

Navigation  
Use Ctrl + F to search this manual for content. 

The table of contents is clickable - click on any line in the table of contents to be taken directly to that chapter/sub-chapter. 

New to Excel?  
Start with the Introduction, Interface, and Excel Basics chapters to acquaint yourself with Excel. These explain how and 
why you need to use Excel and how to navigate through the interface. 

Familiarize Yourself with Excel's Features  
We recommend that you skim through the rest of the manual to familiarize yourself with the features most commonly 
used by legal professionals. Once you are aware of what Excel can do, you can use this manual to guide you every step of 
the way. 

Follow Along  
The rest of the manual walks you through specific applications of Excel using step-by-step instructions and screenshots. 
Recreate our data in your own workbook or apply the steps directly to your own data. 

Future Reference  
Hold onto a (digital) copy of this manual for future reference. Whenever you get stuck, you can refer it the instructions at 
any time. 
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1 INTRODUCTION 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

HOW LEGAL PROFESSIONALS  CAN USE EXCEL  

This manual focuses on the fundamentals and legal-specific applications of Microsoft Excel. Many legal 
professionals initially wonder how a spreadsheet program like Excel might be used in the practice of law. As you 
will see, Excel is a powerful and easy to use program for organizing and managing textual and numeric data. Excel 
also provides the user with the ability to perform an amazing array of calculations including financial, date & time, 
math & trigonometry, statistical, database, and logical calculations. Data is easily converted into charts and graphs 
and Excel is also an extraordinary tool for maintaining lists and creating tables.   

WHY LEGAL PROFESSIONALS  NEED TO LEARN EXCEL  

The best bang for your technology dollar is to learn to use the technology you already own. Since Excel comes with 
Microsoft Office and most organizations already own it, Excel is a classic example of this. Upon completion of this 
course, you might wonder why you didn't start using Excel sooner. 

TERMS USED HEREIN  

Quick Access Toolbar  

The Quick Access Toolbar ("QAT") is located at the top of the Excel window and contains shortcuts to a few 
functions. 

 
FIGURE 1-1 

mailto:manuals@affinityconsulting.com
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File Menu/Backstage View in Excel 2010  

This is located in the upper left-hand corner. Throughout this manual, it is referred to as the File menu. It looks like 
this: 

 
FIGURE 1-2 
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File Menu View in Excel 2013/16  

This is very similar to Excel 2010. As with Excel 2010, it is referred to as the File menu. 

 
FIGURE 1-3 
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File Menu View in Excel 2019/365  

This is very similar to Excel 2013/2016. Microsoft continues to tweak the File menu view in 2019/365. 

 
FIGURE 1-4 
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Start Screen in Excel 2013/16/19/365  

Excel 2013 introduced a new start screen.  

 
FIGURE 1-5 

The start screen can be turned off by clicking the File menu (you have to be in a blank workbook to get to the File 
menu)  Options (left side)  General (left side, top)  Uncheck Show the Start screen when this application 
starts  click OK. 

 
FIGURE 1-6 

CURRENT FILE TYPES  

Description of the Current File Types  

Excel 2007 introduced four (4) new types of files .xlsm, .xlsx, .xltm and .xltx (designated by Microsoft as the "Office 
XML Formats"). They carry forward to Excel 2010 and 2013. The first two are document files, the last two are 
templates. The difference is in whether or not they can contain macros. .xlsx and .xltx cannot contain macros. .xlsm 
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and .xltm can contain macros. The ability for macros to be stored in the old file types opened the door to many 
types of "macro viruses." By creating files which cannot contain macros, you gain a significant measure of 
protection against such things. For the most part, lawyers will be using .xlsx files. 

Benefits of the Current File Types  

Without going into a big techno-babble description, the new formats are much less likely to get corrupted, and 
they're smaller than the old file types (in terms of bytes). The text of the new documents is stored as XML 0F

1 which 
is effectively plain text. The exclusion of macros offers a measure of protection against viruses and the text being 
stored as XML further reduces security concerns. This additional security means that the new files can pass through 
corporate firewalls without being intercepted as a security risk. Finally, the XML format allows any application 
supporting XML to access and work with data in the new file format. The application does not need to be part of 
the Microsoft Office system or even a Microsoft product. This was a distinct shortcoming of the .doc file type since 
the format is proprietary to Microsoft and they do not release their source code to the public. For Microsoft's 
explanation of the benefits of the new file formats, please see http://tinyurl.com/2j2g8s. 

 
1 XML stands for Extensible Markup Language. It is a programming language developed by the World Wide Web Consortium which is an 
"open" standard (not proprietary to any one company) accepted around the world. XML is designed to facilitate the sharing of structured 
data (such as text in a Word document) across different information systems, particularly via the Internet. 
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2 INTERFACE 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

TERMINOLOGY  

The interfaces between 2010, 2013, 2016, 2019, and 365 are slightly different. However, the key functions work 
the same. 

 
FIGURE 2-1 
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FILE MENU/BACKSTAGE VIEW  

The Backstage View shows you everything you can do to the spreadsheet file while the ribbon shows you 
everything you can do in the spreadsheet. 

 
FIGURE 2-2 

QUICK ACCESS TOOLBAR  

Use and modify the Quick Access Toolbar ("QAT") to store your most frequently used commands. By default, the 
Quick Access Toolbar is configured with three (3) buttons: save, undo, and redo/repeat typing. You can easily add 

commands through the Quick Access Toolbar menu by clicking on the  icon next to the toolbar, then choosing 
More Commands. The menu contains items for the most common commands. 

Select one of the common commands to add it to the toolbar. If your toolbar becomes too long for the top of the 
screen, select Show Below the Ribbon to have it appear below the Ribbon. To add other commands or to change 
the order of the icons on the toolbar, select More Commands… to bring up the customize options. You can also 
access this dialog through the File menu  Options  Quick Access Toolbar. 
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FIGURE 2-3 

TABS  

The tabs are located at the top of the screen, immediately below the title bar. The tabs are used to change Ribbons. 

CONTEXTUAL TABS  

Contextual tabs are tabs that appear based on what you have selected in the workbok. For example, there is a 
"Table Tools" contextual tab that appears only if your cursor is within a table. The beauty of contextual tabs is that 
they appear automatically and provide you with every imaginable tool related to edit the object you're working 
on (table, graphic, etc.). 

 
FIGURE 2-4 
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RIBBON  

Ribbons contain (almost) all of the commands that are used to work with the data in the workbook. Each ribbon 
contains a group of related commands and functions. There are 8 main ribbons that are always present, and 
multiple ribbons that only appear with a contextual tab. The 8 main ribbons are: 

Home ................................... Cut, copy & paste, font, alignment, styles, cells & editing 

Insert  .................................. PivotTables, illustrations, charts, links, text 

Page Layout ......................... Themes, page setup, scale to fit, sheet options, arrangement 

Formulas.............................. Functions, defined names, formula auditing, calculations 

Data ..................................... Pulling external data, connections, sort & filter, data tools & outline 

Review ................................. Proofing, comments & changes (protecting, track changes, etc.) 

View .................................... Views, show/hide, zoom, window controls & macros 

Developer ............................ Optional - visual basic code, controls, XML 

Help(2019/365) ................... Help, support, training, and community features 

RIBBON CONTROLS  

There are several different types of controls on the ribbon. Commands are arranged into groups. Groups contain 
a variety of buttons, galleries and launchers. Galleries are groups of large buttons with showing a preview of the 
formatting that will be applied by clicking the gallery entry. Hovering over a gallery entry will cause Excel to display 
a "live preview" of the formatting in the document without actually applying the change. 

Not every command is displayed in the ribbon. Extra options for a group of commands can be accessed by clicking 
a launcher. The launcher will "launch" a dialog with additional options and controls. In addition, a button may have 
an arrow (triangle) that provides additional options. 

 
FIGURE 2-5 
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3 EXCEL BASICS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

WHAT IS A WORKBOOK?  

When you start Excel, a new blank workbook will appear on your screen, ready for you to begin work. A workbook 
is comprised of worksheets (3 of them initially in 2010 and 1 in 2013/16/19/365, but more can be added). Each 
worksheet is comprised of 1,048,576 rows (numbered) and 16,384 columns (lettered), the intersections of which 
are called cells (there are 17,179,869,184 per worksheet). Each cell can hold a separate piece of information (text, 
dates, numbers); and can hold up to 32,767 characters. 

The current cell is designated by the cell pointer and you can only enter information into the current cell. Each cell 
has its own cell address which combines the column letter with the row number (i.e., B2). An interesting feature 
of a cell is that it can hold not only a formula, but also the value calculated by that formula. The beauty of this is 
that the formula inside one cell can use information stored in other cells. When the information in the other cells 
is changed, then the cell containing the formula automatically updates itself. As such, you can adjust the inputs 
and see how they affect the output immediately. 
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FIGURE 3-1 

NAVIGATING WORKSHEETS  

To navigate around a worksheet, one may use keystrokes or the mouse. 

Navigation Keystrokes: Where the Cell Pointer Moves: 

→ or Tab Cell to the right 

 or Shift + Tab Cell to the left 
 Up one row 
 Down one row 

Home Cell in Column A of the current row 

Ctrl + Home Cell A1 of the worksheet 

Ctrl + End Cell at the intersection of the last column that contains data and the last row 
that contains any data 

PgUp Up one screen 

PgDn Down one screen 

Ctrl + → First cell to the right that has a blank cell before or after it 

Ctrl +  First cell to the left that has a blank cell before or after it 

Ctrl +  First cell above that has a blank cell before or after it 

Ctrl +  First cell below that has a blank cell before or after it 
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Ctrl + PgDn Last cell in the next worksheet that contains data 

Ctrl + PgUp Last cell in the previous worksheet that contains data 

Ctrl + G Go to a specific cell address 

 

FILE OPERATIONS  

Creating a New Workbook  

When you start Excel 2010, a new blank workbook will appear on your screen, ready for you to begin work. In Excel 
2013/16/19/365, you will be prompted to a create a new file based on a choice of template. The "blankworkbook" 
template will open the blank workbook that is automatically opened in Word 2010. 

If you wish to create a new blank workbook, click the File menu  New  Blank workbook (SK: Ctrl + N). 

Save a Workbook  

To save your workbook, either click the File menu  Save or click the Save button  on the Quick Access Toolbar 
(SK: Ctrl + S). 

Using Save As  

Use the Save As command from the File menu for the following purposes: (1) to save a document with a different 
file name; (2) to save a workbook in a different location; or (3) to save as a workbook template or some other 
format. To use Save As, simply click File menu  Save As (SK: F12).  

Closing a Workbook  

To close a workbook, click the Close button  in the top right corner of the window. Alternatively, you can 
click the File menu  Close. 

If there were changes made since the last save, Excel will ask you if you want to save the changes. 

Opening a Document  

To open a saved workbook, click the File menu  Open (SK: Ctrl + O). 

CREATING NEW FOLDERS & RENAMING FILES  

When saving workbooks (or files), you should always save them in the appropriate client or matter folder. Many 
times, you will have to create that folder because it hasn't been created yet. You can do this inside Excel or in File 
Explorer. Below is an explanation of how to create a new folder from inside Excel. 

To create a new folder inside of Excel, you must be in the Save, Save As or Open dialog. 

1. File menu  Save As. 

2. Office 2016/2019/36: click on Browse. 

3. Select the folder where you want to create a new subfolder. 

4. Click the New Folder button and give the folder a name. 

5. Type the name of the file and click the Save button. 

RENAMING FILES OR FOLDERS  

1. In the Open or Save As dialog, right-click on the name of the file (or folder). 



 CHAPTER 3 
 

MICROSOFT EXCEL FOR LEGAL PROFESSIONALS  Page 14 

2. Select Rename from the menu. 

3. Type the new name and hit Enter. 

or 

1. In the Open or Save As dialog, left-click on the name of the file (or folder) so it is highlighted. 

2. Left-click on the name of the file or folder again (do not click the little icon to the left of the name). 

3. Type the new name and hit Enter. 

GETTING HELP  

Excel's Built-In Help  

Excel 2010: Click the little  button at the top right corner of the Excel window. 

Excel 2013: Click the  button at the top right corner of the Excel window. 

Excel 2016/19: Use the  search bar to search the help. 

Excel for Microsoft 365: Use the  bar to search the help. 

MVPS Web Site  

The Most Valuable Professionals web site has a wealth of Excel help web sites. Go to http://tinyurl.com/6cobml 
for the full list. 

Other Web Sites  

• www.mrexcel.com 

• www.exceltips.com 
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4 ENTERING DATA 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

BEST PRACTICES  

There are a few guidelines which will help you when entering data into a worksheet: 

• If possible, organize your data into table format using adjacent rows and columns.  

• Include row headings (if applicable) in column A. 

• Include column headings whenever practical in row 1. 

ENTERING DATA  

To enter data in a worksheet, first click in the cell you want to populate and start typing. As you type, the characters 
appear both in the cell your cell pointer is in and at the top of the worksheet in the formula bar. When you're done, 
click on the Enter/Return key, Tab, or an arrow key () on your keyboard to exit the cell. 

DATA CLASSIFICATION  

Each time you enter data into a cell, Excel classifies it as either text, a value or a formula. If Excel thinks you've 
typed a formula, it will calculate the result and display it in the cell. If Excel thinks you've entered text, it aligns it 
against the left edge of the cell. If Excel thinks you've entered a value (quantities, dates, or times), it aligns it against 
the right edge of the cell.  

Note: Excel has introduced several new types of data in Microsoft 365. These have limited application for legal 
professionals are not addressed in this manual. 

Text  

To enter text, simply type the text in the cell. 

Number Values  

To enter a number, simply type it in the cell along with any necessary decimal points. To enter a negative value, 
begin the entry with the minus sign/hyphen (-). 

Date Values  

If you don't enter the date in a format Excel recognizes, it will classify it as text. This is a problem if you intend to 
perform calculations using those dates, easily reformat the date later on, or use it in a PivotTable. You can perform 
calculations from date values but not from dates stored as text. 

Excel recognizes the following date formats: 

• November 2, 1966 or November 2, 66 

• 11/2/66 or 11-2-66 
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• 2-Nov-66 

• 2-Nov 

• Nov-66 

Time Values  

Once again, if you want to perform calculations, you'll need to enter your time as a value. 

Excel recognizes the following time formats: 

• 6:30 PM 

• 6:30:02 PM 

• 18:30 

• 18:30:02 

Formulas  

When entering a formula, simply begin the entry with the equal sign (=) and continue typing your formula. Most 
formulas follow the equal sign with one of Excel's built-in functions (as described in subsequent chapters). 
Formulas can also use + for addition, - for subtraction, * for multiplication, and / for division. 

EDITING CELLS  

There are several ways to edit the contents of a cell. If you click on a cell that already contains data and begin 
typing, it will replace the existing contents. If you'd rather edit the existing contents double-click in the cell and hit 
F2 on your keyboard to "reopen" the contents. Alternatively, you can edit the contents in the formula bar. 
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5 INTRODUCTION TO FORMULAS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

WHAT IS A FORMULA?  

A formula is an equation that performs calculations in a cell, such as adding quantities, calculating dates, or 
changing capitalization of text. Formulas can be manually entered (i.e., =A1+A2) or can use functions (such as 
SUM). Functions are pre-defined formulas that perform a variety of computations. 

To use formulas, you must furnish the values necessary for the function to perform its calculation. These values 
are called arguments. For example: 

=(A1+35)/SUM(B1:B5) 

Where: 

A1  =  cell reference 

+  =  addition operator 

35  =  numeric constant 

/ = division operator 

SUM(B1:B5)  = worksheet function  

(B1:B5) = range reference (refers to cells B1 through B5) 

Formulas using functions can be directly entered into the cell. For example, typing =SUM(A1:D1) would calculate 
the sum of cells A1, B1, C1 and D1. 

FUNCTION ARGUMENTS DIALOG  

If you are unsure of a function's arguments, you can open the Function Arguments dialog using the Insert Function 
button or the Formulas ribbon.  



 CHAPTER 5 
 

MICROSOFT EXCEL FOR LEGAL PROFESSIONALS  Page 18 

 
FIGURE 5-1 

Insert Function Button  

You can use the Insert Function button (to the left of the formula bar or on the Formulas ribbon) to open the 
Function Arguments wizard after you have entered a formula or before entering a formula. To use the Insert 
Function button, position the cell pointer on the cell you'd like to enter the formula into and click the Insert 
Function button. 

 
FIGURE 5-2 

If you have not yet entered a formula, the Insert Function button will require you to select a function from the list. 
The Insert Function dialog box contains a list of function categories at the top and the specific functions under 
each category are listed in the Select a function. The Most Recently Used function category will always be 
highlighted by default, but you can select any of the other categories to view the functions listed thereunder. You 
will notice that when you click on a function name, a description of the function appears at the bottom of the 
Insert Function dialog along with a diagram displaying the syntax and arguments necessary to complete the 
function. 
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FIGURE 5-3 

Formula Ribbon  

Alternatively, you can open the Function Argument dialog from the Formula ribbon in the Function Library group. 
Dropdown the function category buttons to see the functions available under each. 

 
FIGURE 5-4 

Using the Function Arguments Dialog  

The function arguments are listed at the top of the dialog. Click in the box next to any argument to see help text 
below. 
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FIGURE 5-5 

To reference a cell, either type the cell reference (ex: A1) or click on the cell. The Function Arguments dialog can 
be moved around the worksheet so you can see the underlying cells you're working with. Simply click and hold 
anywhere in the dialog except in a field or on a button and drag the dialog where you'd like it and release the 
mouse button. 

ORDER OF OPERATIONS -  HOW EXCEL PROCESSES FORMULAS  

Excel calculates formulas from left to right, according the order of operations. If you combine several operators in 
a single formula, Excel performs the operations in the order shown in the following table. If a formula contains 
operators with the same precedence. For example, if a formula contains both a multiplication and division 
operator, Excel evaluates the operators from left to right. 

1. ( ) Parentheses 

2. – Negation (as in –1)  

3. % Percent  

4. ^ Exponentiation  

5. * and / Multiplication and division  

6. + and – Addition and subtraction  

7. & Connects two strings of text (concatenation)  

8. = < > <= >= <> Comparison 

An easy way to remember the order of the most common operators is the phrase Please (parentheses) Excuse 
(exponentiation) My (multiply) Dear (divide) Aunt (add) Sally (subtract).  

Therefore, the formula =10+5*2/5 returns the value of 12, not 6. The answer is 12 because the multiplication 
occurs first (5*2), then the division (moving left to right - 10/5), then the addition (10+2). If you wanted this formula 
to process strictly left to right, then you would need to change it as follows: =(10+5)*2/5. 
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6 AUTOFILL AND THE FILL HANDLE 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Excel can automatically continue a series (list) of numbers, dates, or time periods based on a pattern you establish. 
You can also set up custom series to automatically replicate using Autofill. Further, Autofill can be used to enter 
repetitive formulas across rows or columns. Let Excel do the data entry work for you. 

FILL HANDLE  

Invoke autofill by selecting the appropriate cells and dragging the fill handle. The fill handle is located in the bottom 
right-hand corner of the selected cell(s). It appears as a small square in the outline around the selected cell(s). 

 
FIGURE 6-1 

The fill handle can be drug in any direction. Drag it down a column to populate the series downward (or up a 
column to populate it upward). Drag it across a row to populate the series to the right (or left). 

BUILT- IN AUTOFILL  EXAMPLES  

Excel is set up to autofill patterns based on numbers, dates, times, or combination of numbers and text. 

Numbers  

Excel can extend various numerical patterns. The most common numerical pattern is to count (1, 2, 3, 4, 5, etc.). 
However, if you enter a single number (such as a "1"), select it, and drag and then release the fill handle, the cells 
will all populate with the number 1. To fix the issue, you need to give Excel a pattern to replicate. Instead, type "1" 
in the first cell and "2" in the second cell. Select both cells; then use the fill handle. 

Excel can also autofill numbers based on other patterns, such as odd or even numbers. Start by entering two or 
more numbers in their own cells (such as "1" and "3"), selecting them, and using the fill handle. 

Dates  

Excel can extend series of dates. The most common date-based pattern is to increment days (1/1/2020, 1/2/2020, 
1/3/2020, etc.) Unlike numerical patterns, if you enter a date and use the fill handle, Excel will automatically 
increment the date by one day for each cell you autofill. Unlike the Numbers example above, you do not need to 
enter multiple dates to begin. 

If you'd like to increment by a different number of days, by months, or by years, start by entering the first two 
dates in their own cells. Then select those cells and use the fill handle. 

Full dates are not required for Autofill. Excel can also extend series of months, days of the week, quarters, or years. 
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Times  

Like dates, Excel can also extend series of times. To extend times by one hour, you only need to enter the initial 
hour. Select the cell and autofill from there. Anything more complicated than that will require entering the pattern 
in multiple cells first. 

CUSTOM AUTOFILL LISTS  

In addition to the foregoing, you can also create your own Autofill lists. For example, if you're always creating 
worksheets which contain a list of the attorneys in your department and you're tired of typing them in every time, 
you can let Autofill do the work for you. Follow these steps to make that list a permanent option and then drop it 
into a new workbook. 

First create the custom list: 

1. Type the list of names, each name in its own cell across a row or down a column.  Either a row or 
column will work. 

 
FIGURE 6-2 

2. Select the list (drag with your mouse). 

3. File menu  Options button  Advanced  General section  Edit Custom Lists button. 

 
FIGURE 6-3 

4. Import button. 
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FIGURE 6-4 

5. Click OK. 

To use the custom list in any workbook: 

1. Type a name in the custom list you previously created. 

2. Use the autofill handle (as described above) to populate the list across a row or up/down a column. 

AUTOFILLING FORMULAS  

Sometimes, you need to repeat a formula, such as a total column. In the first row, you enter the formula to sum 
that row. Then, you need to repeat that formula for the other rows. 

 
FIGURE 6-5 

You can use the autofill handle to copy the formula from one cell to the next, just as if you were creating a list. The 
formula will automatically adjust the cell references as it autofills. Learn more about cell references in Chapter 7. 
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7 CELL REFERENCES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

In many cases, the number that appears in one cell must appear in several other cells. In order to minimize the 
possibility of error, it is a good idea to let the user enter the number once and read it into the other cells (so the 
user doesn't have to enter it more than once). 

READ INS  

If the value is changed in the original cell, it will automatically update everywhere that reads into that cell. 
Therefore, if there is even a slim possibility that the value will change, you should use a read in for all places that 
value is used. 

 
FIGURE 7-1 

Read-In on the Same Worksheet  

There are multiple different ways to accomplish this. Follow the steps for one of the methods below. 

Type 

1. Click in the destination cell: B5. 

2. Type =B3 and hit Enter. 

3. The number in cell B3 will now appear automatically in cell B5. 

Click 
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1. Click in the destination cell: B7. 

2. Type =. 

3. Click in the cell you want to read in: B3. 

4. Hit Enter. 

5. The number in cell B3 will now automatically appear in cell B7. 

Read-In from a Different Worksheet  

You can take a value from a cell on one worksheet and read it into other worksheets in the same workbook. Simply 
follow these for one the methods below. 

Copy and Paste 

1. Click on the cell you want to copy and copy (KS: Ctrl + C). 

2. Right-click in the destination cell: B13. Use the paste link button  to paste a link to the copied cell. 

Click 

1. Click on the destination cell: B15. 

2. Type =. 

3. Select the worksheet with the data with the cell data you want to read in. 

4. Select the cell with the data you want to read in. 

5. Hit Enter. 

Read-In from a Different Workbook  

Follow the steps to paste the link or click above, but switch to the target workbook rather than a different 
worksheet in the source workbook. 

ABSOLUTE CELL REFERENCES  

If you copy a formula that includes cell references, the cell references will automatically shift with the formula. For 
example, if cell C3 contains the formula =SUM(A3:B3) and you copy that formula to cell D3, the formula will adjust 
the cell references to =SUM(A4:B4). 

Excel tracks how many rows and columns you move from the copied cell and adjusted the cell references 
accordingly. If you move down two cells and to the left three cells, Excel will adjust all references by two rows and 
three columns. 

However, sometimes, you don't want the cell references to adjust. In that case you need absolute cell references. 
You can create absolute cell references by using a $ or by naming cells (see Chapter 8 for instructions on using cell 
names). 
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FIGURE 7-2 

In the example above, if you copy the formula in cell B5 (=A5*C3), the formula will change to =A6*C4. A6 is the 
cell you want to multiply by 10%, but since the cell reference shifted to C4 instead of C3, the formula no longer 
works. So the problem we're solving here is that we want the reference to cell C3 to stick but allow the reference 
to the cell in column A to shift. 

Absolute Cell Reference  

In the example above, we never want the row or column reference to shift. To prevent such a shift, we need to 
insert a $ before both the row and column references. 

1. Create the formula in B5: =A5*C3. 

2. Edit the formula (KS: F2). 

3. Add $ symbols before the column and row references to C3: =A5*$C$3. 

4. Copy the formula down into cells B6-B9 (see Chapter 11). 

Adding the dollar signs to the cell reference causes the reference to stick and not shift with the formula. 

Absolute Row Reference  

Sometimes, you only need an absolute reference to the row. When you copy the formula up or down a column, 
you need the row to stay the same, but if you copy the formula across a row, you need the column to shift. In that 
case, place the $ only in front of the row reference. 

=A4*C$3 

Absolute Column Reference  

Sometimes, you only need an absolute reference to the colun. When you copy the formula up or down a column, 
you want the row to stay the shift, but if you copy the formula across a row, you need the column to stay the same. 
In that case, place the $ only in front of the column reference. 

=A4*$C3 
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8 CELL NAMES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Cells can always be referred to by their column and row reference (ex: A2). However, you can give cells explicit 
names to make formulas easier to read and copy. For example, the formula 

=A2*B2*C2 

could be 

=Quantity*Unit_Price*Sales_Tax_Rate 

if A2 was named Quantity, B2 was named Unit_Price, and C2 was renamed Sales_Tax_Rate. 

Names can be up to 255 characters long and may not contain spaces. However, _ and . are acceptable characters. 

RENAMING CELLS  

Cells can renamed using the name box, the define name button, or create from selection method. 

Name Box  

When renaming cells using the name box, it does not matter what ribbon you are in. 

1. Click on the cell. 

2. Click in the Name box. 

 
FIGURE 8-1 

3. Type the name. 

4. Hit Enter. 
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Define Name Button  

1. Click on the Formula ribbon  Define Name button. 

 
FIGURE 8-2 

2. Excel will attempt to name the cell based on the content in the cells surrounding the cell. Rename the 
cell as necessary. 

3. Click OK. 

 
FIGURE 8-3 

Create from Selection  

If you have a group of cells that need renamed that have names next to them (see the example below), you can 
use the Create from Selection button to rename them more efficiently. 

 
FIGURE 8-4 

1. Select the cells, including the labels (A1:B4 above). 



 CHAPTER 8 
 

MICROSOFT EXCEL FOR LEGAL PROFESSIONALS  Page 29 

2. Formula ribbon  Create from Selection button. 

 
FIGURE 8-5 

3. Select where the labels are located (in this case, the left column). 

4. Click OK. 

 
FIGURE 8-6 

Excel automatically names the cells based on the labels selected. 

NAMING RANGES  

A range of cells is a group of cells. Ranges can be named for easily reference in formulas. For example, the SUM 
function sums ranges of cells. 

Either the Name Box or Define Name Button methods described above work for naming ranges. Start by selecting 
the range, then follow the steps as described above. 

USING CELL NAMES  

Existing Formulas  

When you rename cells, existing references to the cell's row and column will not automatically change to reflect 
the new name. The row and column reference will continue to work. 

Excel can automatically replace the row and column references with the new names: 

1. Click on the Formula ribbon  Define Name button dropdown arrow. 

2. Select Apply Names… 
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FIGURE 8-7 

3. Click on each name to select it. 

 
FIGURE 8-8 

4. Click OK. 

New Formulas  

If you write a new formula that references a named cell by clicking on the cell, Excel will automatically use the 
name. You can also type the name to reference that cell. 

MANAGING CELL NAMES  

To see and manage a list of all named cells (and ranges), you need the Name Manager. You'll find the Name 
Manager on the Formulas ribbon. 

 
FIGURE 8-9 
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From the Name Manager, you can see a list of all names. You can create new names, edit names, or delete names. 

 
FIGURE 8-10 
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9 BRINGING EXCEL TABLES INTO WORD 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Generally speaking, if you are working with a table of numbers in a Word document, you're better off setting up 
the numbers in Excel and copying the results into your Word document. Of course, you can automatically add, 
multiply, etc., in a Word table, but it's equivalent to mowing your lawn with a pair of scissors. It's much easier to 
let Excel do the number crunching or sorting and then copy and paste it into your Word document. There are three 
primary ways to accomplish this. 

No matter the method you choose, start by setting up your data in Excel, selecting the data, and copying it (KS: 
Ctrl + C). 

SIMPLE WORD TABLE  

When using a straight copy-and-paste into Word (KS: Ctrl + V), it will come in as a plain Word table. 

The only thing you need to know in advance is that if you're working with currency, don't format the currency in 
Excel using the "Accounting" format (which puts the dollar sign at the far left of the cell). This format doesn't copy 
well into Word. Instead, make sure you're using the "Currency" format in Excel which copies to Word perfectly.  

Keep in mind that once you've pasted into Word, the table in Word is not connected to the source workbook. 
Furthermore, if you make changes to the numbers in the Word table, it will not automatically re-calculate (to the 
extent you had formulas in the source workbook). 

INSERT WORKSHEET OBJECT  

If you have formulas in your source workbook, it might be a good idea to retain that functionality after you paste 
into Word so that if you need to edit the numbers, formulas will re-calculate themselves. 

WARNING: This procedure pastes the entire workbook into the Word document. Someone who knows what 
they're doing would be able to see all of the worksheets in the workbook with little trouble. So don't disclose 
something you didn't intend to disclose.  

1. In Word, click on the Paste down arrow  Paste Special… 

 
FIGURE 9-1 
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2. Select the Paste radio button. 

3. Select Microsoft Office Excel Worksheet Object. 

4. Click OK. 

 
FIGURE 9-2 

This will insert the table as an object that resembles clipart or a field. Now that the table is inserted, double-click 
on it and Word appears to morph into Excel. You can make changes to the worksheet and the formulas will update 
themselves. When you're done, click somewhere else in the document and the Excel overlay will disappear. Keep 
in mind that it's not linked back to the source workbook. 

LINK TO SOURCE WORKBOOK  

Sometimes you want to retain the connection to the source workbook when you paste into Word. In that manner, 
you can't change the inserted spreadsheet from the Word document. However, whatever changes you make in the 
source Excel workbook will be immediately reflected in the Word document you pasted into. 
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1. In Word, click on the Paste down arrow  Paste Special… 

 
FIGURE 9-3 

2. Leave the Paste link radio button selected. 

3. Select Microsoft Office Excel Worksheet Object. 

4. Click OK. 
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10 REVIEWING AND PROTECTING WORKSHEETS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

COMMENTS  

Adding Comments to s Workbook  

You can easily add comments to a worksheet you're reviewing. Simply click on the cell you want to comment on, 
then click on Review ribbonNew Comment button. 

 
FIGURE 10-1 

Excel 2010/13/16/19  

In Excel 2010/13/16/19, type your comment.  

 
FIGURE 10-2 

Excel for Microsoft 365  

In Excel for Microsoft 365, type your comment. You must then post your comment by clicking on the post button. 

 
FIGURE 10-3 
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Comments can also be replied to in Excel for Microsoft 365. 

 
FIGURE 10-4 

Changing the Way Comments Appear in Worksheet  

By default, comments are only indicated by a red triangle in the right, upper corner of a cell. When you hover over 
the, the comment appears. However, you can change the way Excel displays them by clicking the File menu  
Advanced  Display heading. Under For cells with comments, show: select the desired method of showing 
comments. 

 
FIGURE 10-5 

Printing Comments  

By default, comments do not print at all. If you'd like to print them, click the Page Layout ribbon  Page Setup 
Launcher  Sheet tab. Change the option for Comments. 

 
FIGURE 10-6 
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TRACK CHANGES  

WARNING: This feature is no longer supported by Microsoft. When tracking changes, the following features are 
no longer supported: creating or inserting table, adding or changing conditional formats, adding or changing 
data validation, creating or changing charts, inserting or changing pictures/other objects, inserting or changing 
hyperlinks, inserting automatic subtotals, creating PivotTables, creating or applying slicers, and added threaded 
comments. 

Excel has a track changes feature similar to the one in Microsoft Word.  

Office 2010/2013/2016: Turning on Tracked Changes  

To turn on track changes, simply click the Review ribbonTrack ChangesHighlight Changes. Now check "Track 
changes while editing." 

 
FIGURE 10-7 

Excel 2019/365: Turning on Tracked Changes  

The buttons described below are no longer available on the Review ribbon in Excel 2019/365. However, they can 
be added to the Quick Access Toolbar using the steps below.  

1. Click on the dropdown arrow in the Quick Access Toolbar and click on More Commands. 
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FIGURE 10-8 

2. Change the Choose commands from: to Commands Not in the Ribbon. 

 
FIGURE 10-9 

3. Scroll through the list to find Track Changes (Legacy). Then follow the direction below, except that you 
will click on the new button on your QAT instead of the button on the ribbon. 

 
FIGURE 10-10 

Viewing Tracked Changes  

Changes that you make will be indicated by a blue box around the cell modified and an indicator (triangle) in the 
top, left corner of the cell. When you hover over the cell, it will display a window that explains what change was 
made. 

PROTECTING CELLS IN A WORKSHEET  

Sometimes you want to lock cells down so that others don't over-write your formulas (or otherwise change data). 
Here are the steps necessary to accomplish this: 

1. Select the cells you want to allow users to edit. 

2. Open the Format Cells dialog (KS: Ctrl + 1). 

3. Click the Protection tab. 
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4. Uncheck the Locked checkbox. 

5. In the Review ribbon, click Protect Sheet, and add a password, if desired. 

 
FIGURE 10-11 

The user will be able to modify only the cells you previously unlocked. 
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11 CALCULATING TOTALS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

COLUMN AND ROW TOTALS  

There are multiple ways to calculate column and row totals in Excel.  

While you may be tempted to use the + symbol to add cells (ex: A2+B2+C2), if you are adding a range of cells, this 
is inefficient. Instead, use the SUM function. 

Sum Function  

The SUM function can be inserted by typing it, using in the Insert Function button, or on the Formula ribbon  
Math & Trig dropdown  SUM. 

The SUM function arguments are relatively simple. Enter the range of cells to total. You can enter more than one 
range. 

 
FIGURE 11-1 

AutoSum  

The AutoSum button will attempt to do the work for you.  
1. Click in the cell where you want the total. 

2. On the Formulas ribbon, click on the AutoSum button. (It is also available on the Home ribbon). 
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FIGURE 11-2 

3. Excel will try to determine what you want to total. It will tentatively select the range to total. If it does 
what you want, click Enter. If not, select a new range and click Enter. 

SUB TOTALS  

Sometimes you need to calculate a subtotal (a conditional sum). To create a conditional sum, you want to use the 
SUMIF function. It has three arguments. The first is the range of cells to be evaluated. The second is the criteria 
against which to evaluate those cells. The third is the range of cells to sum (this argument is optional - you do not 
need it if you are summing the same cells as the ones being evaluated). 

In the example below, we need to calculate the subtotal for each type of property. The range to be evaluated is 
the B2:B10 - the cells that list the property type. The range to be summed is C2:C10 - the cells with the value in 
them. 

 
FIGURE 11-3 

1. Position the cell point in the cell you want to have the subtotal in: C13. 

2. Click the Insert Function button or Formula ribbon. 
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3. Click on the Math & Trig category, then scroll down the list of corresponding functions and click on 
SUMIF. As you can see, SUMIF adds the cells specified by a given condition or criteria.  

4. If using the Insert Function button, click OK. 

5. Click in the Range box and then select cells the cells to evaluate: B2:B10. 

6. In the Criteria box, enter the text "tangible" (including the quotation marks - 2019/365 will add them 
for you). 

7. In the Sum_range box, select cells to be summed: C2:C10. 

8. Click OK. 

9. Repeat this function with the appropriate changes for the other subtotals. 

 
FIGURE 11-4 
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RUNNING TOTALS  

To create a running total (such as the running total of medical expenses below), you need two formulas. First, you 
need to read in the initial amount. Then you need add the next amount to the previous total. 

 
FIGURE 11-5 

1. Click in cell for the first total: E7. 

2. Read in the first amount: =D7. 

3. Click in the cell for second total: E8. 

4. Add the new amount to the prior total: =E7+D8. 

5. Use the AutoFill handle to copy the formula down. (See Chapter 6.) 
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12 FILTERING AND SORTING DATA 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

FILTERING  

If you only want to see a subset of your data, Excel can filter based on the values in a column. First, you need to 
add filters to your data. 

1. Select the rows and columns that contain the data, including the header row.  

2. On the Data ribbon, click on the Filter button. 

 
FIGURE 12-1 

Little down arrows appear at the top of each column heading. 

 
FIGURE 12-2 

To filter the data: 

1. Click the down arrow next the column that contains the criteria for your filtering. 

2. Check the boxes for the values you want to see. 

 
FIGURE 12-3 
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3. Click OK. 

Your data will be filtered to the subset of data you selected. Rows that are filtered out are hidden. 

To remove the filter, click on the down arrow again and check the box next to (Select All). 

SORTING  

Excel can sort your data by values in one or more columns. It can either do a quick sort by the values in one column, 
or you can set up a multi-level sort. 

 
FIGURE 12-4 

Quick Sort  

To quickly sort your data by the values in one column: 

1. Click on a cell in the column whose data you want to sort by. In the example above, we're going to sort 
by property type: click on a cell in column B. 

2. On the Data ribbon, click on the AZ button to quickly sort the data based on the values in that column. 

 
FIGURE 12-5 

If the column contains text, it will sort the data alphabetically. If it contains values, it will sort the data 
in numerical or chronological order. 

3. Excel will automatically determine what data to include in the sort. If it improperly sorts your data, hit 
the undo button (KS: Ctrl + Z) and proceed to the advanced multi-column sort instructions below. 
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Advanced Sort  

If you want to sort by multiple columns or something other than cell values or the instructions above do not work 
for your data set, you'll need to use the Sort dialog box. 

1. Select all cells to be sorted, not just the column to sort by. In the example above, select A2:C10. You 
do not need to select the row with headings. Do not select the row with the grand total (row 11). 

2. On the Data ribbon, click on the Sort button to quickly sort the data based on the values in that 
column. 

 
FIGURE 12-6 

3. If your data has headers, check the box for My data has headers. 

4. In the first row, select the primary sort method. If your data has headers, the headings will appear in 
the Sort by dropdown. If not, the column letters will appear. 

5. Select what to Sort on. Normally, sorts are based on cell values, but you can also sort based on cell 
color, font color, or conditional formatting. 

6. Select the sort Order. Your options will depend on the type of data in the Sort by column. 

7. To further sort your data, click the +Add Level button and repeat the steps above. In this example, we 
might sort by property type, then by value. 

8. Click OK. 

 
FIGURE 12-7 
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13 CALCULATING LOAN PAYMENTS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Excel can easily calculate payments on a loan with the PMT function. This is a great place to use the Naming Cells 
technique discussed on page 27 above. 

  
FIGURE 13-1 

U 

1. Click where you want the payment amount to appear: B8. 

2. Click the Insert Function button or Formula ribbon. 

3. Click on the Financial category, then scroll down the list of corresponding functions and click on PMT.  

4. If using the Insert Function button, click OK. 

5. Move the Function Argument dialog with the mouse so you can see your data. 

6. Click in the Rate box. While we typically think of interest rate as annual rates (such as the 4.25% 
above), Excel needs the interest rate per period. You need to divide the given rate by the number of 
period per year: B5/B6. 

7. Click in the Nper box to enter the total number of payment for the loan. This this case, we need to 
multiply the number of payments per year by the total number of years: B4*B6. 

8. Click in the Pv box to enter the present value (the loan amount): B3. 

9. Click OK. 
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FIGURE 13-2 

The payment amount should be a negative amount. Make sure it is about the amount you'd expect for a payment 
on that loan. 
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14 CALCULATING DATES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

ADDING DAYS AND WEEKS  

Adding Days  

Excel stores dates as the number of days since January 1, 1900. As a result, you can easily add days to a date using 
addition.  

1. Click in the cell where you want the calculated date to appear. 

2. Type =. 

3. Click on the date to manipulate. 

4. Type + and the number of days you want to add. 

5. Hit Enter. 

=C5+3 

Adding Weeks  

Since every week has 7 days without exception, you can add weeks to a date just like you would add days. Start by 
multiplying the number of weeks times 7 to get the number of days to add. You can either do that in your head or 
have Excel do the work for you. 

=C5+7*2 

In the example above, Excel will multiply 7 by 2 first, because of the order of operations. No parentheses are 
needed. 
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ADDING MONTHS  

 
FIGURE 14-1 

There are several ways to perform date calculations based on number of months. The methods below use the 
example above to calculate the number of months after a date. 

Method #1: The long way.  

1. Click on cell C9  

2. Click the Insert Function button and choose Function Category Date & Time and then click DATE 
under Function Name, and click OK. 

3. You should see the following window: 

 
FIGURE 14-2 
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4. In the Year window, enter the following which pulls out the year of the date of appointment: YEAR(C6) 

5. Since the due date for this task is 3 months after the date of appointment, we need to pull out the 
month of the appointment date and add 3 months. Therefore, we need to enter the following in the 
Month blank: MONTH(C6) + 3 

6. In the Day window, enter the following which pulls out the day of the date of appointment: DAY(C6) 

7. Utilize this same technique for cells C10 through C13. 

 
FIGURE 14-3 

Method #2: Use the EDATE formula.  

1. Click on cell C9. 

2. Go to the Formula ribbon, click Date & Time. 

3. Select the EDATE function 

4. In the Start_date type C6, in Months type 3. 

 
FIGURE 14-4 

5. Click OK. 

6. Utilize this same technique for cells C10 through C13. 
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15 IF THIS, THEN THAT 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Conditional cell contents are achieved using logical formulas. The most basic logical function, available in all 
supported versions of Excel, is IF. Microsoft 365 introduced two new logical functions: IFS and SWITCH. 

IF  FUNCTION  

IF tests to see whether a condition is met. The formula's output depends on whether or not the condition is met. 

 
FIGURE 15-1 

1. Click on cell C6.. 

2. On the Formulas ribbon, under Logical, click on IF. 

3. For the Logical_test, write an expression that evalutes to true or false. In this example, enter B6 > B3 
to test whether the attorney's hours are greater than the billable hour requirement. 

4. For the Value_if_true, insert the output when the condition is met. In this example, we want to output 
yes if the attorney's hours are greater than the billable hour requirement. Text values must appear 
inside quotation marks. Excel for Microsoft 365 will add the quotes for you automatically. Older 
versions of Excel require you to type them. 

5. For the Value_if_false, insert the output for when the condition is not met. In this example, we want 
to output no if the attorney's hours are not greater than the billable hour requirement. Text values 
here must also appear inside quotation marks. 

6. Click OK. 
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FIGURE 15-2 

IFS  (365)  

Excel for Microsoft 365 introduces a new function that allows you test on multiple conditions. For example, IFS will 
allow you determine which clients you are sending cards, candy, or cookies to depending on the amount they paid 
you last year. For other versions of excel, see instructions on nesting IF functions on page 57. 

 
FIGURE 15-3 

1. Click in cell C2. 

2. On the Formulas ribbon, under Logical, select IFS. 

3. For the Logical_test1, write an expression that evalutes to true or false. In this example, enter B2 < 
5000. We want to test whether the client paid less than $5,000 last year. 

4. For the Value_if_true1, enter the output when the condition is met. In this case, holiday card.  Text 
values must appear inside quotation marks. Excel for Microsoft 365 will add the quotes for you 
automatically. Older versions of Excel require you to type them. If the first condition is met, Excel will 
enter this output and stop processing additional arguments. 

5. For the Logical_test2, write a second expression that evalutes to true or false. In this example, enter  
B2 <= 10000. We want to test whether the client paid no more than $10,000 last year. If the client paid 
less than $5,000, the cell is output "holiday card," so we do not need to worry about the minimum 
amount of this range. 

6. For the Value_if_true2, enter the output when the condition is met. In this case candy. Text values 
must appear inside quotation marks. 
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7. Continue this process until you run out of conditions. In this case, repeat it a third time using B2 > 
10000 as the logical test and cookies as the output. 

 
FIGURE 15-4 

SWITCH (365)  

The SWITCH function allows you to test against a list of values. It requires simpler arguments than IFS, but only 
works for values that are equal to one another (not less than or greater than). For example, SWITCH will allow you 
to search through a list of attorneys to determine which assistant will be assigned to a matter. For other versions 
of excel, see instructions on nesting IF functions on page 57. 

 
FIGURE 15-5 

1. Click in cell C3. 

2. On the Formula ribbon, under Logical, click on SWITCH. 

3. For the Expression, enter the value for which you are looking for a match. In this example, enter B3. 
We will be searching through the list of attorneys for the name of the attorney assigned to this matter. 

4. For the Value1, enter the first value in the list. In this example, enter F3 - the first attorney in the list 
of attorneys. 
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5. For the Result1, enter the output if the first value is a match. In this example, enter G3 - the assistant 
who works for the first attorney in the list. 

6. Repeat steps 4 and 5 for each value in the list. 

 
FIGURE 15-6 
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16 NESTING FORMULAS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Sometimes, you need multiple formulas to get the result you need. For example, we may need to determine how 
many years it has been since a client executed their estate plan. If we have the execution date, we need to subtract 
the year of the execution from today's date.  

You can either use a different cell for each step or you can nest the formulas in one cell. 

USING MULTIPLE CELLS  

Using multiple cells, we can achieve the desired result: 

1. Start by calculating the year of execution. 

 
FIGURE 16-1 

2. Then, calculate today's date. 

 
FIGURE 16-2 

3. Calculate the year of today's date. 

 
FIGURE 16-3 

4. Subtract the year of execution from the current year. 

 
FIGURE 16-4 
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USING NESTED FORMULAS  

Using multiple cells takes 4 columns. If the formulas are nested, it only takes one column. 

 
FIGURE 16-5 

NESTING IF FUNCTIONS  

The IF function (see Chapter 15) allows you to control the contents of a cell based on whether a condition is met. 
Sometimes, however, you need additional options. Microsoft 365 subscribers can use Ifs or SWITCH (see Chapter 
15). If you are not a microsoft 365 subscriber, you can nest IF functions to achieve the same result. 

In this example, we are sending holiday gifts that depend on the amount that each client paid us last year. We 
need to see where the amount billed falls within three ranges. A single IF function is not enough. 

 
FIGURE 16-6 

1. Click in cell C2. 

2. On the Formulas ribbon, under Logical, click on IF. 

3. For the Logical_test, type the first test. In this example, B2 < 5000. 

4. For the Value_if_true, insert the output when the condition is met. In this case, enter "holiday card". 

5. For the Value_if_false, enter a placeholder such as "X". 
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FIGURE 16-7 

6. Click OK. 

7. Click on cell C2. 

8. In the formula bar, select everything other than the "=" and copy it. (CTRL + C or right-click and select 
copy.) 

9. Select the placeholder inside the formula ("X"). 

10. Paste the copied text over the placeholder. (CTRL + V or right-click and select Paste). 

 
FIGURE 16-8 

11. In the nested IF function, replace the first argument with the new condition to be met. In this example, 
replace B2 < 5000 with B2 <= 10000. 

12. In the nested IF function, replace the second argument with the new output when the condition is 
met. In this example, replace "holiday card" with "candy". 

13. In the nested IF function, replace the third argument with the new output when the condition is not 
met. (If you have more than 3 possible outputs, you will need to repeat these steps to nest additional 
IF functions.) In this example, replace "X" with "cookies". 
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FIGURE 16-9 
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17 FORMATTING WORKBOOKS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

SELECTING CELLS TO BE FORMATTED  

When entering data into a worksheet, the typical practice is to enter everything first, and then format it so that it 
looks presentable. 

In order to format cells, they must first be selected. There are several ways to select cells: 

• Click on a cell, hold down the left mouse button and then drag the mouse across the sheet 

• If you want to select other cells that aren't adjacent to the first selection, you can hold down on the 
Ctrl button, click somewhere else in the worksheet and select other cells without losing the original 
selection. 

• You can also select cells with the keyboard. First position the cell pointer where you want to start the 
selection, hold down on Shift and use the arrow keys to expand the selection. 
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APPLYING FORMATTING TO CELLS  

Once cells are selected, you can apply formatting to them by going to the Home Ribbon and applying formatting, 
or hit Ctrl + 1 to open the Format Cells dialog. 

 
FIGURE 17-1 

ADJUSTING THE HEIGHT OF ROWS AND WIDTH OF COLUMNS  

Row Height  

Row height can be adjusted by clicking the Home ribbon  Format button  Row Height (default is 15). If you 
want to resize multiple rows to the same height, this is the best way to ensure consistency. 

 
FIGURE 17-2 

Height can also be adjusted with the mouse by positioning the mouse pointer on the line between two numbered 
rows. When the white plus cursor changes to a black up and down arrow, you can hold down on the mouse button 
and drag the mouse down to increase the height of the row above the cursor or up to decrease it. Double-click to 
have the row automatically resize to fit the tallest cell in the row. 

Column Width  

Column width can be adjusted by clicking the Home ribbon  Format button  Column Width (default is 8.43). 
If you want to resize multiple columns to the same width, this is the best way to ensure consistency. 



 CHAPTER 17 
 

MICROSOFT EXCEL FOR LEGAL PROFESSIONALS  Page 62 

Width can also be adjusted by placing the mouse cursor between two lettered columns. When the white plus 
cursor changes to a black left and right arrow, you can hold down on the mouse button and drag the mouse left to 
decrease the width of the column to the left of the cursor or to the right to increase the width of the column to 
the left of the cursor. Double-click to have the column automatically resize to fit the widest cell in the column. 

MERGING CELLS  

Merging cells allows you to combine multiple cells into one. This is most useful when need to center content across 
multiple columns. 

1. Select the cells to merge. 

2. On the Home ribbon, click on the Merge & Center button. 

 
FIGURE 17-3 

CONDITIONAL FORMATTING  

Conditional formatting is a means of changing the formatting for a cell or group of cells automatically when certain 
conditions are met. For example, if the number in a cell is greater than 5,000, you could use conditional formatting 
to automatically turn the number red or highlight the cell, etc. You can also test on the result of a formula.  

To use this feature, select the cell(s) you want to conditionally format, then click Home ribbonConditional 
Formatting button. As you can see from the following screen shot below, you have many options for what you're 
testing on.  
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FIGURE 17-4 

Below is an example where any cell containing a value over 5,000 will be formatted with red text. 

 
FIGURE 17-5 
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18 HEADERS, FOOTERS, AND PRINTING 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

PAGE LAYOUT VIEW  

Page Layout View shows you how the workbook will look when printed. You can switch to this view by clicking the 
View ribbon  Page Layout button. Very importantly, this view will allow you to see headers and footers on the 
screen. 

HEADERS/FOOTERS  

To add headers and/or footers to your worksheets: 

1. Click the Insert ribbon  Header and Footer button. Three things will happen when you do this: 

• You will switch to Page Layout view 

• Your cursor will be blinking inside the center footer box 

• A new contextual tab will appear providing buttons for anything you would want to insert into a 
header or footer. 

 
FIGURE 18-1 
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2. The Header and Footer buttons provide you with any pre-fab options; or you can use the buttons in 
the Header & Footer Elements group to manually insert what you want. 

3. Note that there are three boxes in each header and footer (left, center and right). 

PRINTING GRIDLINES  

By default, Excel doesn't print gridlines (lines between cells). You can see them when you're working on a 
worksheet, but they do not print. If you want them to print, you have two options. 

Print All of the Grid Lines  

To print all of the gridlines as you see them on the spreadsheet, click the Page Layout ribbon  check the Gridlines 
Print box.  

 
FIGURE 18-2 

Add Borders  

Alternatively, you can add borders to the places you want to see gridlines. Select the cells you want to apply 
borders to, click the Home ribbon  Borders button  choose All borders. 

 
FIGURE 18-3 
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PRINTING ROW AND/OR COLUMN HEADINGS  

Row headings are the row numbers to the left of the worksheet; column headings are the letters that appear at 
the top of the columns on a worksheet. If you want them to print with your worksheet, click the Page Layout 
ribbon  check the Headings Print box. 

 
FIGURE 18-4 

REPEATING ROW AND/OR COLUMN LABELS (TITLES)  

This is extremely useful if you have a long spreadsheet and you want to label the columns and/or rows on the 
second and subsequent pages.  

1. Click the Page Layout ribbon  Print Titles button. 

2. Click in the Rows to repeat at top. 

3. Select the row(s) to repeat at the top of every page. 

4. Click in the Columns to repeat at left. 

5. Select the column(s) to repeat at the left of every page. 

 
FIGURE 18-5 
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FITTING TEXT ON A PAGE WHEN PRINTING  

Unless you're working with a very small worksheet, never print without first looking at the print preview screen so 
you can see what will fit on the page. In the alternative, simply stay in Page Layout view and you'll know exactly 
how it will look. In any event, you'll often have to manipulate the worksheet in order for it to fit on the page the 
way you'd like. 

Standard Modifications  

If you're trying to get something to fit on the width of a page, you can always modify the margins (Page Layout 
ribbon  Margins button), change the orientation to landscape (Page Layout ribbon  Orientation button) or 
make your columns narrower. 

Scaling to Fit  

If you just want to shrink the worksheet to fit on a certain number of pages, you can scale it down by using the 
Width, Height and Scale adjustments on the Page Layout ribbon.  

 
FIGURE 18-6 

PRINTING A PARTICULAR SECTION OR RANGE  

There are many times when you only want to print a sub-section of your worksheet or a particular area (i.e., not 
the whole thing). This is easily done with the Print Area feature. Simply follow these steps: 

1. Select the area of the worksheet you want to print. 

2. Click the Page Layout ribbon  Print Area button  Set Print Area. 

Now only the selected area will print. If you want to clear that, click the Print Area button again, then choose Clear 
Print Area. As an aside, the print area setting is also accessible from the Page Setup dialog (launcher in the Page 
Setup group of the Page Layout ribbon) on the Sheet tab. 
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19 PRODUCING CHARTS AND GRAPHS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

WHY WOULD A LEGAL PROFESSIONAL NEED CHARTS OR 
GRAPHS?  

Graphically representing data helps people understand it better. A few examples: 

• Producing a bar chart for a trial presentation. 

• Producing a pie chart which demonstrates to an estate planning client what percentage of their estate 
will be paid in taxes without estate planning and what percentage will be paid if they engage in estate 
planning. 

• Graphically representing accounting data for insertion into an Asset Purchase agreement. 

CHARTING DATA  

Excel makes it very easy for you to create fancy charts from your data by using the Chart Wizard. The basic 
procedure is to select the data you'd like to chart, click the Insert ribbon  click the button corresponding to the 
type of chart you'd like to produce: 

 
FIGURE 19-1 

Clicking the launcher on the Charts group will also present you with all charting options. 

In this example, we'll insert a column chart. 

1. Select the cells with data, including the header row (if any). 

2. Click the Insert ribbon  Column Chart button select a type of column chart to include. 
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FIGURE 19-2 

3. Your graph will instantly appear "floating" in the middle of the worksheet you started with. 

 
FIGURE 19-3 

4. In Excel 2010, you'll also have 3 new Contextual Tabs that appear whenever you're working with a 
chart: 

 
FIGURE 19-4 

5. In Excel 2013/16/19/365, you'll have 2 new Contextual Tabs that appear whenever you're working 
with a chart: 
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FIGURE 19-5 

6. To change the chart from a floating type object in your worksheet to a worksheet of its own, click  
Design ribbon  Move Chart button  select New Sheet  click OK. 

 
FIGURE 19-6 
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20 EXCEL AS A MAIL MERGE DATA SOURCE 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

You can use a mail merge to send letters or faxes to your clients, notify employees about their vacation balances 
in personalized e-mail messages, or produce labels and envelopes for client mailings (think Holiday cards or 
announcements). 

CLIENT COMMUNICATION  MAIL MERGE  

Attorney John Smith is an estate planning lawyer and maintains a list of his estate planning clients in an Excel 
workbook. He has a column for a description of the documents he drafted for each client, columns for the name 
and address of the client, a column for the location of the original documents (in his vault or with the client) and 
a column for the date the documents were executed. Once a year, John sorts his estate planning workbook by the 
date the documents were executed and sends letters to all of them whose documents were executed 2 years ago 
or earlier. The letter simply informs the client the date the documents were originally executed and reminds them 
that if circumstances have changed (marriage, divorce, children, etc.), the documents should be updated. The 
clients appreciate the communication and reminders; and John benefits by plenty of return business. This entire 
process is easily automated using Word's Mail Merge function. 

Setup Guidelines  

Excel workbooks make an excellent data source for mail merges using Microsoft Word. For example, I could 
maintain a list of Christmas or Hanukah card recipients (names and addresses) in Excel and use it to print labels in 
Word. For another example, a Legal professional could use it to maintain a list of estate planning clients and the 
dates their documents were executed. That list could then be used to generate follow up letters to the clients in 
subsequent years to see if they want to update their estate plans.  

NOTE: Remember two things: 1) each record is represented by a row and each column represents a field; and 2) 
you need a "header row" which are the labels for each column (see below). 

 
FIGURE 20-1 

Steps to Follow  

Steps for Word: 
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1. Click the Mailings ribbon. 

2. Click Start Mail Merge button  Letters. 

3. Click Select Recipients  Use Existing List  Browse to your spreadsheet  choose the worksheet 
with your data  OK. 

 
FIGURE 20-2 

4. Click Edit Recipient List if you want to add or remove recipients to filter which records will be involved 
in this merge. 

5. Create your letter and insert your merge fields using the Insert Merge Field button, Address Block 
button, or the Greeting Line button. 

6. When you're ready, click Finish & Merge and choose to choose to edit the individual documents  

FORMATTING A DATE MERGE FIELD  

Unfortunately, if you merge a field from an Excel workbook that contains a date, it brings in the date in the format 
06/03/2003 regardless of how it’s formatted in the source workbook. If you’d like the date formatted as June 3, 
2003, follow these steps. For purposes of this example, assume that the date field in our merge document is called 
«Executed». 

1. Right-click the «Executed» field and choose Toggle Field Codes from the menu that appears. 

2. Now the field will look like this: {MERGEFIELD “Executed”}. 

3. Click between the {} brackets and modify it so that it looks like this: {MERGEFIELD “Executed” \@ 
“MMMM d, yyyy” \* MERGEFORMAT} This must be manually typed. 
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21 MANIPULATING TEXT 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

COMBINE & SPLITTING TEXT  

Simple Combination  

Let's say you have one column of first names and another of last names. You want them combined into a single 
column.  

METHOD #1 - FLASH FILL (Excel 2013/16/19/365): 

1. Put your cell pointer in E4. Type the contents of cells A4-D4 (ex: "Mr. Barron K. Henley"). 

2. Put your cell pointer in E5. Begin typing the contents of Cells A5-D5 (ex: "Mr. Paul J. Unger"). 

3. After entering the first few characters of B5, Excel will show you gray text as shown below. Hit the 
enter key on your keyboard to complete the flashfill. 

 
FIGURE 21-1 

METHOD #2 - TEXTJOIN (2019/365 only): 

1. Put your cell pointer in the column where you'd like the combined names  click Insert Function. 
Select TextJoin. 

2. In Delimiter, type " ". 

3. In Text1, enter the cell address that contains the prefix. 

4. In Text2, enter the cell address that contains the first name. 

5. In Text3, enter the cell address that contains the middle name. 

6. In Text4, enter the cell address that contains the last name. 
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FIGURE 21-2 

METHOD #3 - &: 

1. Put your cell point in the column where you'd like the combined names. 

2. Type =, then the address of each cell containing the contents of the names in order, separated by &" 
"&. It should look similar to this: 

 
FIGURE 21-3 

METHOD #4 - CONCAT (2019/365)/CONCATENATE (2010-2016): 

1. Put your cell pointer in the column where you'd like the combined names  click Insert Function. 
Select Concat/Concatenate. 

2. In Text1, enter the cell address that contains the first name. 

3. In Text2, enter the a space (using the spacebar) 

4. In Text3, enter the cell address containing the last name. 

5. Hit Enter  copy the formula down the column. 
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FIGURE 21-4 

Complex Combination  

This is only needed for users with version of Excel prior to 2016. Textjoin (available only in 2016 - see above) 
replaces this fairly complicated formula. 

Now let's assume you have columns for first, middle and last names, but sometimes there isn't a middle name or 
initial. Using the CONCATENATE formula by itself will result in two spaces between the first and last names if the 
middle initial/name cell is blank. In this case, you'll need to use the IF and ISBLANK formulas to get this to work. 
See the screenshot below for how it will look. The explanation is below that: 
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FIGURE 21-5 

• Text1 is the cell address containing the first name. 

• Text2 is the blank space after the first name. 

• Text3 contains IF(ISBLANK(B2),"",B2&" "). To make sense of this, you need to understand the syntax 
for the IF function. It works like this: IF(logical_test, [value_if_true], [value_if_false]). ISBLANK simply 
returns a TRUE or FALSE value based upon whether the referenced cell is blank or not. So here's what 
the whole thing means: If cell B2 ISBLANK, then insert nothing ("" = nothing). Otherwise, insert the 
value in cell B2 plus a space (B2&" "). 

• Text4 is the cell address containing the last name. 

CHANGE CASE  

1. =UPPER() - converts to all caps 

2. =LOWER() - converts to all lower case 

3. =PROPER() - capitalizes first letter of each word 

Distributing (Splitting) Data Across Columns  

You can split words across columns using many techniques. One easy way to do it is the Text to Columns command 
on the Data ribbon. To split data across columns, follow these steps: 

1. Select the data you want to split. 
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FIGURE 21-6 

2. On the Data ribbon, click the Text to Columns button. 

3. Choose Delimited and click the Next button. 

4. Under Delimiters, choose "Space" and click the Next button. 

 
FIGURE 21-7 

5. In the next dialog, click the Finish button and you're done! 
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22 LOOKING UP VALUES IN A LIST 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

If you need to search for values in a list, you can use the VLOOKUP function to scan a column or the HLOOKUP 
function to scan a row (V for vertical and H for horizontal). In Microsoft 365, XLOOKUP replaces the need to use a 
VLOOKUP or HLOOKUP (although those are both still an option). 

 
FIGURE 22-1 

VLOOKUP  

In the foregoing table, assume you want to look up the regular rate for a Senior Shareholder. Just follow these 
steps to write the formula: 

1. Put your cursor in the cell where you want the result to appear and click the insert function button 

. 

2. Type VLOOKUP in the "Search for a function" box and click the GO button.  

3. Click on VLOOKUP from the list under "Select a function" and click the OK button. 

4. In the Lookup_value box, type Senior Shareholder. 

5. In the Table_array box, enter the range of cells containing data (A6:C14). 

6. In the Col_index_num box, enter 2 (you want it to return a value from the 2nd column). 

7. Click OK. See below for how your formula should look in the wizard. 
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FIGURE 22-2 

XLOOKUP (365)  

It is a little bit easier with XLOOKUP: 

1. Put your cursor in the cell where you want the result to appear and click the insert function button 

. 

2. Type XLOOKUP in the "Search for a function" box and click the GO button.  

3. Click on XLOOKUP from the list under "Select a function" and click the OK button. 

4. In the Lookup_value box, type Senior Shareholder. 

5. In the Lookup_array box, enter the range of cells containing data to look for the value entered above 
- in this case, the positions (A6:A14). 

6. In the Return_array box, enter the range of cells with values you want to return - in this case the 
regular rate (B6:B14). 

7. Click OK. See below for how your formula should look in the wizard. 

 
FIGURE 22-3 

LOOKING UP DATA ACROSS WORKBOOKS  

Sometimes, the data you need to look up is located in a different workbook. VLOOKUP, HLOOKUP, and XLOOKUP 
work exactly the same way. 

1. Start by opening up both workbooks. 

2. Follow the steps above. When selecting cells, move your cursor into the other workbook to select the 
cells in it. 
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23 DATA VALIDATION 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

Formulas rely on cells having the correct data into your workbook. Data validation forces users to enter data in the 
proper format. It can be used to add dropdown options to cells or to force users to enter particular types of data 
(such as dates or numbers). 

ADD DATA VALIDATION  

Whether you want to force users to pick from a set of dropdown options or only enter a date, the first couple of 
steps are the same: 

1. Select the range of cells you want to add data validation to. 

 
FIGURE 23-1 

2. On the Data ribbon, click the Data Validation button, and choose Data Validation. 

 
FIGURE 23-2 
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DROPDOWN OPTIONS  

To add dropdown options to one or more cells: 

1. Follow the steps on page 80 above to open the Data Validation dialog. 

2. Under Allow, choose List. 

3. In the Source box, type the list of options separated by commas and click OK. 

 
FIGURE 23-3 

When you click on one of the cells, you'll see a drop-down arrow to the right of the cell. Click on the dropdown 
arrow to select from the options. If you try to enter a value not in the list, you'll get an error message. 

 
FIGURE 23-4 
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DATES  

Specific Date Range  

To force someone to enter a date within a specific range of dates: 

1. Follow the steps on page 80 above to open the Data Validation dialog. 

2. Under Allow, choose Date. 

3. Under Data, choose between. 

4. Enter the Start date and End date for your range. 

 
FIGURE 23-5 
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Any Date  

To prevent someone from entering anything other than a date: 

1. Follow the steps on page 80 above to open the Data Validation dialog. 

2. Under Allow, choose Date. 

3. Under Data, choose not equal to. 

4. For the Date, enter a date that would never be used in your data (a date far in the past often works 
well). 

 
FIGURE 23-6 
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NUMBERS  

To prevent someone from entering something other than a number: 

1. Follow the steps on page 80 above to open the Data Validation dialog. 

2. Under Allow, choose Whole number or Decimal. Use whole number if you want to prevent decimals 
from being entered. 

3. Under Data, choose not equal to. 

4. For the Value, enter a number that would never be used in your data (a extremely large number often 
works well). 

 
FIGURE 23-7 
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24 TABLES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

ADVANTAGES  

Tables make it easier to work with large data sets that are arranged in rows and columns. Advantages inclue: 

• Automatic Header and Total Rows. With the check of a box, you can automatically include header and 
total rows. 

• Automatic Expansion. Tables automatically expand as you add new rows and columns. Formatting and 
formuals automatically carry over the new rows and columns. 

• Formula Replication. Formulas automatically replicate to new rows and blank cells in the same 
column, eliminating the need to copy and paste formulas or use auto-fill. 

• Table Styles. Table styles allow you to quickly format the entire table, including banded rows that 
automatically update as rows are added or deleted. 

• Sorting and Filtering. The header row automatically includes controls to sort and filter the data. 

• Removal of Duplicate Data. Tables include tools to remove duplicate data. 

• Structured Referencing. Tables and columns in tables are automatically given names. See Chapter 8 
for more information about cell names. 

INSERTING TABLES  

To create a table: 

1. Click anywhere in the data set. 

2. On the Insert ribbon, in the Tables group, click on Table. (Ctrl + T) 

 
FIGURE 24-1 

3. Verify the range of cells matches your data. 
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FIGURE 24-2 

4. If your data has a header row, ensure that the My table has headers box is checked. 

 
FIGURE 24-3 

5. Click OK. 

AUTOMATIC HEADER ROWS  

The header row provides a name for each column in the table. Each column must have a unique name. Each cell 
in the header row has a dropdown menu for sorting and filtering.  

 
FIGURE 24-4 

Enable the Header Row  

The top row of your data is automatically turned into the header row when the My table has headers box is 
checked (see above). 
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If your table does not have a header row, click in the table, and check the Header Row box on the Table Design 
ribbon. 

 
FIGURE 24-5 

AUTOMATIC TOTAL ROWS  

Total rows allow you to quickly create formulas for each column in the last row of a table. 

Enable the Total Row  

To enable the total row, click in the table, and check the Total Row box on the Table Design ribbon. 

 
FIGURE 24-6 

Using the Total Row  

Click on a cell in the total row to select a function. To use a function not in the list, click on More Functions… 

 
FIGURE 24-7 

AUTOMATIC EXPANSION  

Rows  

When working outside of a table, hitting the tab key will move the cell pointer one cell to the right, regardless of 
whether it has data in it. When workin in a table, the tab key will move the cell pointer one cell to the right until 
you hit the last colum of the table. If the cell pointer is in the last column, hitting the tab key will move the cell 
pointer to the first column of the next row. If the cell pointer is in the last column of the last row (excluding the 
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total row), hitting the tab key will add a new row to the bottom of the table (above the total row, if any) and move 
the cell pointer to the first column of the new row. 

If your table does not have a total row and you enter data in the row below the table, that row will automatically 
become part of the table. 

You can also right-click on a row to insert a new table row. 

 
FIGURE 24-8 

Columns  

If you enter data in the column to the right of the table, the column will automatically become part of the table.  

You can also right-click on a column to insert a new table column. 

 
FIGURE 24-9 

FORMULA REPLICATION  

Formulas automatically replicate to new rows and blank cells in the same column, eliminating the need to copy 
and paste formulas or use auto-fill. 
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TABLE STYLES  

Table styles allow you to quickly format the entire table, including banded rows that automatically update as rows 
are added or deleted. 

Change the Table Style  

To change the table style: 

1. Click in the table and and click on the Table Styles gallery dropdown on the Table Design ribbon. 

 
FIGURE 24-10 

2. Select the desired style. 

Create a New Table Style  

If none of the built in table styles meet your formatting needs, you can create a new table style: 

1. Click in the table and and click on the Table Styles gallery dropdown on the Table Design ribbon. 

 
FIGURE 24-11 

2. Click on New Table Style… 

 
FIGURE 24-12 
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3. Select each Table Element and click on the Format button to change its formatting attributes. 

 
FIGURE 24-13 

4. Click OK. 

Banded Rows and Columns  

Banded rows and columns make it easy to across a row or down a column. To enable banded rows or columns, 
check the corresponding boxes on the Table Design ribbon. 

 
FIGURE 24-14 

SORTING AND FILTERING  

Tables with a header row automatically include the sorting and filtering dropdown for each column. See Chapter 
12 for instructions on sorting and filtering data. You can add Slicers to a table to create visual filters. 
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Inserting Slicers  

To insert a slicer for your table: 

1. On the Table Design ribbon, click on Insert Slicer. 

 
FIGURE 24-15 

2. Check the box next to the column name that contains the data you want to base your filter off of. 

 
FIGURE 24-16 

3. Drag and drop the Slicer to the desired location. 

 
FIGURE 24-17 
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Using Slicers  

To use a slicer to filter the data in the table, click on the item desired item in the list. To filter for multiple items, 

click on the  button. 

 
FIGURE 24-18 

To clear the filter, click on the  button. 

 
FIGURE 24-19 

REMOVAL OF DUPLICATE DATA  

Excel can easily remove rows of duplicate data from a table. To remove duplicate data: 

1. Click in the table. 

2. On the Table Design ribbon, click on Remove Duplicates. 
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FIGURE 24-20 

3. Check the boxes for each column that must match for a row to be considered a duplicate. 

 
FIGURE 24-21 

4. Click OK. 

STRUCTURED REFERENCING  

Tables and columns in tables are automatically given names. See Chapter 8 for more information about cell names. 

Table Names  

Tables are automatically given a name when they are inserted. To rename the table: 

1. Click inside the table. 

2. On the Table Design ribbon, edit the Table Name. 

 
FIGURE 24-22 

3. Hit the Return/Enter key on your keyboard. 
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Column Names  

If the table contains a header row, each column's name is determined by the data in the header row. No two 
columns can have the same name. 
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25 PIVOTTABLES 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

PivotTables are useful for summarizing and analyzing data. PivotTables replace complex formulas with a drag-and-
drop interface, saving you time.  

CREATING PIVOTTABLES  

Setup Your Data  

Before you create a PivotTable, make sure your data has a header row and that all dates are formatted as dates. If 
not, add a row with a meaningful heading for each column and reformat your dates.  

Insert the PivotTable  

1. Click in the data. 

2. On the Insert tab, click on PivotTable. 

 
FIGURE 25-1 

3. Ensure Excel selected the correct range of cells. If not, click in Table/Range, delete the incorrect range, 
and then select the correct range. 

 
FIGURE 25-2 
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4. Click on OK. 

5. Drag and drop the column names from the PivotTable Fields list to the Filters, Columns, Rows, and 
Values areas. Experiment with how moving the column names from one area to another affects the 
PivotTable. See page 110 for examples of how to set up PivotTables to organize data differently. 

 
FIGURE 25-3 

FILTERING PIVOTTABLES  

Filters allow you to change what data is included in the PivotTable with a couple of clicks. To add a filter, drag and 
drop the column name to the Filters area(see above). 
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Using Filters  

To use the filter, click on the dropdown at the top of the PivotTable. 

 
FIGURE 25-4 

Slicers  

Alternatively, you can add a slicer to a PivotTable to allow the data to be filtered. To insert a slicer: 

1. Click in the PivotTable. 

2. On the PivotTable Analyze ribbon, click on Insert Slicer. 

3. Check the boxes next to the column names you want to create slicers for. 

4. Drag and drop the slicer to reposition it. 
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To use the slicer, click on the data you want to see. 

 
FIGURE 25-5 

To select multiple items, click on the  button. 

 
FIGURE 25-6 
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To clear the filter, click on the  button. 

 
FIGURE 25-7 

 

CUSTOMIZING VALUES  

Renaming Values  

Values default to names like Sum of Column Name. To change their name: 

1. Click on the name under Values. 

2. Select Value Field Settings… 

 
FIGURE 25-8 
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3. Change the Custom Name to the desired name. 

 
FIGURE 25-9 

Changing the Type of Values  

Values for columns containing numbers default to the sum of the values. To change that to a count, average, or 
other formula: 

1. Click on the name under Values. 

2. Select Value Field Settings… 

 
FIGURE 25-10 
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3. On the Summarize Values By tab, select the desired formula. 

 
FIGURE 25-11 

Show Value As  

Rather than just showing value, you can show value as a percentage of a total, a difference between two values, 
or rank ordering: 

1. Click on the value under Values, and select Value Field Settings… 

2. Click on the Show Values As tab. 

3. Under the Show values as dropdown, select the desired way to show the value. 

4. Click OK and OK again. 

Number Formatting  

To change the formatting of a number in a PivotTable: 

5. Click on the value under Values, and select Value Field Settings… 

6. Click on the Number Format button. 

7. Select the desired format. 

8. Click OK and OK again. 

SUBTOTALS AND GRAND TOTALS  

PivotTables automatically include Grand Totals and if you drag-and-drop more than one column name into the 
Rows areas, they automatically include Subtotals. 

Subtotals  

To turn off subtotals for a specific row: 
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1. Click on the row and select Field Settings… 

 
FIGURE 25-12 

2. On the Sutotals & Filters tab, under Subtotals, select None. 

 
FIGURE 25-13 
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To turn off subtotal for the entire PivotTable, on the PivotTable Analyze ribbon, click on Subtotals, and select Do 
Not Show Subtotals. 

 
FIGURE 25-14 

To change whether subtotals are shown at the top or bottom of the group, on the PivotTable Analyze ribbon, click 
on Subtotals, and select the appropriate option. 

Grand Totals  

To off grand totals for columns and/or rows, on the PivotTable Analyze ribbon, click on Grand Totals, and select 
the appropriate option. 

 
FIGURE 25-15 

UPDATING DATA  

When you update the data that a PivotTable is based on, the PivotTable does not automatically update to reflect 
the new data. 
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Refreshing the Data  

If the data changed, but no new data was added, you merely need to refresh the data. To refresh the data: 

1. Click in the PivotTable. 

2. On the PivotTable Analyze ribbon, in the Data group, click on Refresh. 

 
FIGURE 25-16 

Changing the Data Source  

If amount of data changed (rows or columns were added or removed), you need to update the data source to 
reflect the new data range: 

1. Click in the PivotTable. 

2. On the PivotTable Analyze ribbon, in the Data group, click on Change Data Source. 

 
FIGURE 25-17 

3. Click in Table/Range, delete the old range, and then select the new range. You will likely need to 
change worksheets to selec the appropriate range.  

 
FIGURE 25-18 

4. Click OK. 
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This is not true if your PivotTable is based on a Table (see Chapter 85). If the PivotTable is based on a Table, you 
merely need to Refresh the data (see above). 

WORKING WITH DATES  

The dates in the underlying data must be properly stored as dates to be useable in a PivotTable. If even one cell in 
your column of dates is incorrectly stored, the PivotTable will treat that data as text rather than dates.  

If you drag-and-drop a date column onto Rows or Columns, it will automatically group the data by years, quarters, 
or months. If there is a problem with your data, it will not group the data. 

 
FIGURE 25-19 

What to Do if Excel Doesn't Recognize Dates as Dates  

In a new column, multiply the date column by 1. If it you get an error message, re-enter the date for that row. 

 
FIGURE 25-20 
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Removing Automatic Groupings  

If you don't want to group your data the way that Excel automatically grouped, drag-and-drop the groups you do 
not want out of the PivotTable areas. 

 
FIGURE 25-21 
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APPEARANCE  

Layout Options  

Report Layout options allow you control how the PivotTable appears. The options are located on the PivotTable 
Analyze ribbon under Report Layout. 

 
FIGURE 25-22 
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Compact, Outline, and Tabular Form change how the PivotTable is spaced out. When multiple column names were 
dragged-and-dropped onto the Rows area: 

• Compact Form nests the rows under each other (see figure 25-23 below). 

• Outline Form gives each row its own column (see figure 25-24 below). 

• Tabluar Form nest the rows into separate columns, but fewer rows (see figure 25-25 below). 

    
FIGURES 25-23, 25-24, AND 25-25 
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When using Outline or Tabular Form, you can elect whether or not you want to repeat labels on each row. For 
example: 

 
FIGURE 25-26 

Style Options  

To change the style of your PivotTable, including turning off special formatting for headers and banded rows or 
columns, click in the PivotTable and check the desired options on the Design ribbon. 

To change the overall color scheme and style, select a new style from the PivotTable Styles gallery. 

 
FIGURE 25-27 
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PIVOTTABLE  EXAMPLES  

Billable Hours and Fees by Matter  

1. Set up your data with columns for the matter, the billable hours, and total fees. 

2. Insert the PivotTable (see page 95 above). 

3. Drag the Matter column to the Rows. 

4. Drag the Hours and Total Fees columns to Values. 

 
FIGURE 25-28 
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Average Billable Rate by Attorney and Practice Area  

1. Set up your data with columns for the matter, practice area, and rate. 

2. Insert the PivotTable (see page 95 above). 

3. Drag the Practice Area column to Rows. 

4. Drag the Attorney column to Rows below Practice Area. 

5. Drag the Date column to Values. 

6. Under Values, click on Sum of Rate (or whatever you named your rate column), and select Value Field 
Settings. 

 
FIGURE 25-29 

7. On the Summarize Values By tab, select Average. 

 
FIGURE 25-30 
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26 GOAL SEEK AND SCENARIO MANAGER 

Goal Seek and Scenario Manager are tools to analyze data and change numbers used in formulas. Goal seeks helps 
you determine what the other numbers must be to meet a particular goal. Scenario Manager tells you what the 
answer is when the other numbers are changed. 

GOAL SEEK  

Chapter 13 covers how to calculate a loan payment when the loan amount, interest rate, frequency of payments, 
and length of the loan are known. However, you might need to calculate how much a person could borrow with a 
particular monthly payment. Use Goal Seek to determine this. 

 
FIGURE 26-1 

1. Add the formula. In this example, use PMT to calculate the loan payment in cell B6 (see Chapter 13). 

2. On the Data ribbon, in the Forecast group, under What-If Analysis, click on Goal Seek. 

3. For Set cell, select the cell with the final result. In this example, the payment (cell B6). 

4. For To value, enter the desired final result. In this example, enter the desired monthly payment 
amount. 

5. For By changing cell, select the cell with the variable amount. In this example, select the loan amount 
(cell B1). 

 
FIGURE 26-2 

6. Click OK. 

7. Click OK again. 
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SCENARIO MANAGER  

Use the Scenario Manager to see what would happen under multiple scenarios (forecasting). Chapter 13 covers 
how to calculate a loan payment. If you want to consider how different loan amounts, interest rates, or the length 
of loan affects the payment, use the Scenario Manager. 

 
FIGURE 26-3 

1. Add the formula. In this example, use PMT to calculate the loan payment in cell B6 (see Chapter 13). 

2. On the Data ribbon, in the Forecast group, under What-If Analysis, select Scenario Manager. 

3. Click on the Add… button. 

4. Name the scenario. 

5. Select the cell(s) to change. To select multiple non-adjacent cells, use CTRL + click. In this example, 
select the term in years and the interest rate (B2:B3). 

 
FIGURE 26-4 

6. Click OK. 
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7. Input the values for this scenario. In this example, set B2 to a 15 and B3 to .025 to see what would 
happen if the loan was reduced to 15 years and a 2.5% interest rate. 

 
FIGURE 26-5 

8. Click OK. 

9. Repeat the steps above to add additional scenarios. 

10. After all scenarios are added, select a scenario in the list and click on the Show button to change the 
values to match that Scenario. 

 
FIGURE 26-6 
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27 OTHER MISCELLANEOUS TIPS & FORMULAS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

CHANGE THE DEFAULT FONTS  

Change the Default for All Future Workbooks  

In Excel 2010/13/16, click the File menu  Options (left side, bottom)  General (left side, top)  change Use 
this as the default font to what you'd like it to be along with the font size  OK. 

Change the Default for the Workbook You're Editing  

In the Styles group on the Home ribbon, right-click the Normal style  Modify  Format button  Font tab at 
the top and make your changes  OK  OK. 

 
FIGURE 27-1 
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PASTE THE VALUE,  NOT THE FORMULA  

If you copy a cell containing a formula and simply hit paste, you are pasting the formula, not the value. This can 
create unexpected results because the cell references in the formula will often adjust automatically. If you want to 
paste the result of the formula you've copied, then just follow these steps after you've copied the cell: 

1. Click the bottom of the Paste button. 

2. Choose the Paste Values button (see below). 

 
FIGURE 27-2 

QUICK ANALYSIS (2016/19/365)  

Quick Analysis analyzes the selected cells and offers suggestions for analyzing that data. It is useful for quickly 
adding conditional formatting, charts, calculating totals, and add tables. 

 
FIGURE 27-3 

1. Select the cells to be analyzed. In this example, select A1:B10. 

2. In the bottom, right-hand corner of the data, click on the Quick Analysis button.  
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FIGURE 27-4 

3. Select the desired analysis type. 

 
FIGURE 27-5 
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